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Introduction

With Find MAC Address, you can find the MAC address of your or remote computer and also of any

computer within the specified range of IP addresses. Unlike similar software, Find MAC Address can find

the MAC addresses of computers using four methods (ARP, NetBios, NetAPI, WMI).

Installing Find MAC Address

You can install Find MAC Address after downloading it from the Downloads page.

Click the Save button to save the installation file. You will see the window showing the progress of

downloading the installation file to your computer.

Run the installation file after it is downloaded.

http://lizardsystems.com/downloads/
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Follow the Installation Wizard instructions after you run the installation file. After the installation is over, you

can start working with the application.

Starting the application

You can start Find MAC Address either from the Start menu

or by clicking its desktop shortcut.
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After you start the application, you will see the main window of the program.



Find MAC Address - Getting Started

6

Main Window

Main Menu

File menu

The File menu includes various commands for controlling the software, saving or opening results, scanning

the network for MAC addresses.
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Open — Load previously saved scan results from XML.

Save — Save the scan results to XML.

Export — Export the scan results to the format that can be read by other applications.

TXT — Notepad or another text editor;

CSV — Excel or another software for working with worksheets;

RTF — WordPad, Microsoft Word or another editor;

HTML — Internet Explorer, Firefox, Opera or another web browser.

Find MAC address — Start the process of scanning and finding the MAC addresses of computers

according to the parameters specified in the Panel Target and Method groups.

Stop process — Stop the process of scanning and finding the MAC address, since multiple threads are

used during the process, it is stopped not immediately, but in a few seconds.

Language — Select the language of the software interface1).

Preferences — Open the Preferences dialog box.

Exit — Exit the program.

 

Edit menu

The Edit menu includes the following commands: Find, Copy, Clear.

Edit comment — 

Find in list — search the results list for the specified text.

Copy — Copy into the clipboard.

• Copy line - Copy the selected line into the clipboard.

• Name - Copy Name into the clipboard.

• IP - Copy IP into the clipboard.

• MAC address - Copy MAC address into the clipboard.

https://lizardsystems.com/wiki/find_mac_address/help/main_menu#fn__1
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• Vendor - Copy Vendor into the clipboard.

• Comment - Copy comment into the clipboard.

Clear — Clear the list of scan results and the scan log.

Tools menu

Administrative tools

Network tools
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Manage tools

View menu

The View menu allows you to customize the work area of the application.
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Show horizontal grid — show the horizontal grid in the list of scan results.

Show vertical grid — show the vertical grid in the list of scan results.

Show striped grid — show the striped list of results.

Show log —  show application log.

Show filter — show MAC adress list filter.

Restore columns order — restore the default column order.

Select Columns — open the Column Settings dialog box.

 

Help menu

The Help menu allows you to open the help file, access the support service and check the software for

updates.

Online help – Open the help page on the program site.

Homepage – Open the application homepage.

Technical support – Open the page where you can request technical support.

Feedback – Open the page where you can send feedback to the developers.

Check for updates… – Check for any updates available for the application.

Get license key – Open the page where you can get registration codes for the application.

Enter license key… - Enter your registration information.

About… – Show brief information about the program.
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Toolbar

The toolbar allows you to quickly access the main features of the software.

Find MAC address — Start the process of scanning and finding the MAC addresses of computers

according to the parameters specified in the Panel Target and Method sections.

Stop process — Stop the process of scanning and finding the MAC address.

MAC Address Manufacturer Lookup — lookup MAC Address Manufacturer in program database.

Load list from file — Load previously saved scan results from XML.

Save list to file — Save the scan results to XML.

Find in list — Open the Find in list dialog box.

Copy to clipboard — Copy the selected line with scan results into the clipboard.

Export — Save the scan results in the format that can be read in other applications.

Clear list — Clear the scan results and the scan log.

Preferences — Open the Preferences dialog box.

Online help – Open the help page on the program site.

Homepage – Open the application homepage.

About… – Show brief information about the program.

Panel Target

You can select one of the six objects for scanning.

Local computer

Find MAC Address will find the MAC addresses of the network cards on the local computer.

The Computer name field shows the name of the local computer and the IP address field shows its IP

address. You cannot edit these values.
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Remote computer

Find MAC Address will find the MAC address of the computer you specify in the input field. You can specify

either the name of the computer or its IP address. If you click the button next to the input field, you will see

the Browse for Computer dialog box where you can select any computer in the network neighborhood and

find its MAC address.

Entire network

Find MAC Address scans the network neighborhood in the same way Windows Explorer does it when you

open My Network Place. The software determines the MAC addresses of all detected computers.

Scan IP address range
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Find MAC Address scans the range of addresses specified in the Start IP and Stop IP fields. You can

quickly add a range of addresses using the network settings of your computer by clicking the My IP range

button. After you click this button, you will see the Calculating IP range dialog box where you can select the

address of your network card.

If you have several network cards, you can use the combo box to select the one you need. The address of

the network card and the subnet mask will be used to calculate the range of addresses for your network.

A click on the OK button in the Local IP range dialog box will close it and the calculated values will be

specified in the input fields.

When you click the B or C button in the Panel Target group, the range of addresses for a network of the B

or C class respectively will be generated according to the values specified in the Start IP field.

Address list

Add Computer - adds a computer to the list.

Find Computers - finds a computer in a network and adds it to the list.

Edit Computer - edits computer name in the list.

Delete Computer - deletes a computer from the list.

Import List - imports the list from a file.

Export List - exports the list to a file.
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Active Directory

Expression

Panel Method

Before you start the scan process, you can select the method you want to use to find the MAC address

Find MAC Address uses one of the four scan methods, you can choose any of them:

ARP — uses the SendARP function to get the MAC address of a remote computer. This function uses an

ARP request in order to get the physical address (the MAC address) for the specified IP address. The

equivalent command is arp -a. The computer being scanned must be located in the same subnet as

yours.

NetBIOS — uses NetBIOS functions to get the MAC address of a remote computer. NetBIOS functions

allow applications on different computer establish a link between themselves via the local area network.

The equivalent command is nbtstat -a. NetBIOS must be enabled on the computer being scanned.
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Net API — uses the Windows Networking API to get the MAC address of a remote computer. The

equivalent command is getmac. NetBIOS must be also enabled for this method.

WMI — uses Windows Management Instrumentation functions to get the MAC address of a remote

computer and other parameters of its network card. If you use this method for scanning, you will be also

able to find out the name of the network card. You must be logged as an administrator on the

computer being scanned.

SNMP — uses Simple Network Management Protocol to get the MAC address of a remote computer and

other parameters of its network card. If you use this method for scanning, you will be also able to find out

the name of the network card.

Scan results

All detected computers and their MAC addresses are shown in the list of scan results. You can view the list

as a tree or as a flat list. The view depends on the scan method.

For example, the list is displayed as a tree if you scan and Find MAC Addresses using the NetAPI, WMI or

SNMP method.

<image>

The list is displayed as a flat list when you scan and determine MAC addresses using the ARP and NetBIOS

methods.

<image>

The following menu will appear if you click on the item in the list of scan results.

The following menu will appear if you click the title of a column in the list of scan results.
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The first half of the menu contains the list of columns in the list. You can show or hide the selected column

by selecting or clearing the corresponding item.

Show horizontal grid — show the horizontal grid in the list of scan results.

Show vertical grid — show the vertical grid in the list of scan results.

Show striped grid — show the striped list of results.

Restore columns order — reset the column order to the default.

Select Columns — open the Column Settings dialog box.

Application log

The scan log contains messages the software makes while scanning and finding MAC addresses.
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Dialog boxes

MAC Address Manufacturer Lookup

Find in List

You can use this dialog box to search the result list.

Type what you are looking for in the Find what field and click the Find button. After the software finds a

matching text, the line with this text will be selected. Each time you click the Find button again after that, the

software will search the list for the text further.

Column Settings

You can use this dialog box to customize the order and appearance of the list with scan results.



Find MAC Address - Getting Started

18

• Change the size of columns in pixels by entering the value in the Selected column should be field.

• You can also align text in columns: Left, Right, Center.

To apply the made changes, click the OK button.

 

Preferences

You can use this dialog box to specify the default parameters of the software.
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General

Columns — defines how computers will be displayed in the list of scan results.

Clear list before find MAC address — if the checkbox is selected, the results of the previous scan, as

well as the scan log, will be cleared each time you start a new scan.

Inverse log order - inverts message order in log.

Scanning
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Threads - allows to change threads number for finding mac addresses.

Device name - allows to select what computer name to find:

Don't find device name

DNS Name

Netbios name

Detect DNS name if Netbios name failed

Timeout — you can specify the time the software should wait for the remote computer to respond to your

request, the time is specified in milliseconds. If the computer does not respond to the request within the

specified time, it is considered inactive and it is not scanned.

Check state

This tab contains the parameters of checking the state of the computers being scanned.

You can use this tab to select how the software should check the state of the remote computer. Before

scanning a computer, the software checks its state. If the computer is switched off, it will not be scanned and

its MAC address will not be found. There are two ways to check the state of a computer — a ping or a

connection to the specified port.

Don't check state — the state of the computer will not be checked. No matter whether the computer is

switched on or off, the software will try to find its MAC address.

Ping — a ping is used to check the state of the computer.

TCP Connect to port — a connection to the specified port is used to check the state of the computer.

The port number must be greater than 1 and less than 65535.

Don't check state if ARP, Netbios or SNMP method is used.
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